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RISK OF ELECTRIC SHOCK
DO NOT OPEN

CAUTION

CAUTION: TO REDUCE THE RISK OF ELECTRIC SHOCK,

DO NOT REMOVE COVER (OR BACK)

NO USER-SERVICEABLE PARTS INSIDE

REFER SERVICING TO QUALIFIED

SERVICE PERSONNEL.

The lightning flash with arrowhead symbol, within an equilateral triangle, is intended
to alert the user to the presence of uninsulated “dangerous voltage” within the
product’s enclosure that may be of sufficient magnitude to constitute a risk of electric
shock.

The exclamation point within an equilateral triangle is intended to alert the user to the
presence of important operating and maintenance (servicing) instructions in the litera-
ture accompanying the appliance.

WARNING:
TO PREVENT FIRE OR SHOCK HAZARD, DO NOT EXPOSE THIS APPLIANCE TO RAIN OR
MOISTURE.

CAUTION:
TO PREVENT ELECTRIC SHOCK, DO NOT USE THIS (POLARIZED) PLUG WITH AN EX-
TENSION CORD, RECEPTACLE OR OTHER OUTLET UNLESS THE BLADES CAN BE
FULLY INSERTED TO PREVENT BLADE EXPOSURE.

NOTE:
SINCE THIS PROJECTOR IS PLUGGABLE EQUIPMENT, THE SOCKET-OUTLET SHALL BE
INSTALLED NEAR THE EQUIPMENT AND SHALL BE EASILY ACCESSIBLE.

WARNING
Use the attached specified shielded power-supply
cord.  If you use another cord, it may cause interfer-
ence with radio and television reception.

Use the attached RGB cable, RS-232C cable with
this equipment so as to keep interference within the
limit of a Class A device.

The projector automatically shuts off
when the lamp is used up in about
2,000 hours, and the projector will not
turn on until lamp is replaced.

DO NOT LOOK DIRECTLY INTO THE LENS
WHEN PROJECTOR IS IN THE POWER ON
MODE.
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Important safeguards
PLEASE READ ALL THESE INSTRUCTIONS RE-
GARDING YOUR LCD PROJECTOR  AND RETAIN
THEM FOR FUTURE REFERENCE. FOLLOW ALL
WARNINGS AND INSTRUCTIONS MARKED ON
THE  LCD PROJECTOR.

1. Read instructions
All the safety and operating instructions should
be read before the appliance is operated.

2. Retain instructions
The safety and operating instructions should be
retained for future reference.

3. Warnings
All warnings on the appliance and in the oper-
ating instructions should be adhered to.

4. Instructions
All operating instructions must be followed.

5. Cleaning
Unplug this projector from the wall outlet be-
fore cleaning it. Do not use liquid aerosol clean-
ers. Use a damp soft cloth for cleaning.

6. Attachments and equipment
Never add any attachments and/or equipment
without the approval of the manufacturer as
such additions may result in the risk of fire, elec-
tric shock or other personal injury.

7. Water and moisture
Do not use this projector near water or in con-
tact with water.

8. Accessories
Do not place this projector on an unstable cart,
stand, tripod, bracket or table. Use only with a
cart, stand, tripod bracket, or table recommended
by the manufacturer or sold with the projector.
Any mounting of the appliance should follow the
manufacturer's instructions and should use a
mounting accessory recommended by the manu-
facturer.

An appliance and cart combination should be
moved with care. Quick stops, excessive force and
uneven surfaces may cause the appliance and
cart combination to overturn.

10. Power sources
This projector should be operated only from the
type of power source indicated on the marking
label. If you are not sure of the type of power,
please consult your appliance dealer or local
power company.

11. Power-cord protection
Power-supply cords should be routed so that they
are not likely to be walked on or pinched by items
placed upon or against them. Pay particular at-
tention to cords at plugs, convenience receptacles,
and points where they exit from the appliance.

12. Overloading
Do not overload wall outlets and extension cords
as this can result in a fire or electric shock.

13. Objects and liquids
Never push objects of any kind through open-
ings of this projector as they may touch danger-
ous voltage points or short-out parts that could
result in a fire or electric shock. Never spill liq-
uid of any kind on the projector.

14. Servicing
Do not attempt to service this projector yourself.
Refer all servicing to qualified service person-
nel.

15. Damage requiring service
Unplug this projector from the wall outlet and
refer servicing to qualified service personnel un-
der the following conditions:
(a) If the power-supply cord or plug is dam-

aged.
(b) If liquid has been spilled, or objects have

fallen into the projector.
(c) If the projector does not operate normally

after you follow the operating instructions.
Adjust only those controls that are covered
by the operating instructions. An improper
adjustment of other controls may result
in damage and may often require exten-
sive work by a qualified technician to re-
store the projector to its normal operation.

(d) If the projector has been exposed to rain
or water.

(e) If the projector has been dropped or the
cabinet has been damaged.

(f) If the projector exhibits a distinct change
in performance - this indicates a need for
service.

16. Replacement parts
When replacement parts are required, be sure
that the service technician has used replacement
parts specified by the manufacturer or parts
having the same characteristics as the original
part. Unauthorized substitutions may result in
fire, electric shock or other hazards.

17. Safety check
Upon completion of any service or repair to this
projector, ask the service technician to perform
safety checks determining that the projector is
in a safe operating condition.

9. Ventilation
Slots and openings in the cabinet are provided
for ventilation, ensuring reliable operation of the
projector and to protect it from overheating. Do
not block these openings or allow them to be
blocked by placing the projector on a bed, sofa,
rug, or bookcase. Ensure that there is adequate
ventilation and that the manufacturer's instruc-
tions have been adhered to.
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WARNING:
Unplug immediately if there is
something wrong with your projector.
Do not operate if smoke, strange noise or odor comes
out of your projector. It might cause fire or electric
shock. In this case, unplug immediately and contact
your dealer.

Never remove the cabinet.
This projector contains high voltage circuitry. An
inadvertent contact may result in an electric shock.
Except as specifically explained in the Owner's
Guide, do not attempt to service this product
yourself. Please contact your dealer when you want
to fix, adjust or inspect the projector.

Do not modify this equipment.
It can lead to fire or electric shock.

If you break or drop the cabinet.
Do not keep using this equipment if you break or
drop it. Unplug the projector and contact your dealer
for inspection. It may lead to fire if you keep using
the equipment.

Do not face a lens to the sun.
It can lead to fire.

Use correct voltage.
If you use incorrect voltage, it can lead to fire.

Do not place the projector on uneven
surface. Level stable surface only.
Please do not place equipment on unstable surfaces.
Do not look into the lens when it is operating. It may
hurt your eyes.
Never let children look into the lens when it is on.

COMPLIANCE NOTICE OF FCC
This equipment has been tested and found to comply with the limits for a Class A digital device, pursu-
ant to Part 15 of the FCC Rules.  These limits are designed to provide reasonable protection against
harmful interference when the equipment is operated in a commercial environment.  This equipment
generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance
with the instruction manual, may cause harmful interference to radio communications.  Operation of
this equipment in a residential area is likely to cause harmful interference in which case the user will
be required to correct the interference at his own expense.
This digital apparatus does not exceed the Class A limits for radio noise emissions from digital appara-
tus as set out in the interference-causing equipment standard entitled “Digital Apparatus”, ICES-003 of
the Department of Communications.

Changes or modifications not expressly approved by Mitsubishi could void the user's authority to oper-
ate this equipment.

COMPLIANCE NOTICE OF INDUSTRY CANADA
This Class [A] digital apparatus meets all requirements of the Canadian Interference-Causing Equip-
ment Regulations.

Do not turn off the main power
abruptly or unplug the projector
during operation.
It can lead to lamp breakage, fire, electric shock or
other trouble.

Place of installation
For safety’s sake, refrain from setting the projector at
any place subjected to high temperature and high
humidity. Please maintain an operating temperature,
humidity, and altitude as specified below.

• Operating temperature: between +41°F (+5°C) and
+95°F (+35°C)

• Operating humidity:  between 30 and 90%
• Never put any heat-producing device under the pro-

jector so that the projector does not overheat.
• Do not attach the projector to a place that is un-

stable or subject to vibration.
• Do not install the projector near any equipment that

produces a strong magnetic field. Also refrain from
installing near the projector any cable carrying a
large current.

• Place the projector on a solid, vibration free sur-
face: otherwise it may fall, causing serious injury
to a child or adult, and serious damage to the prod-
uct.

• Do not stand the projector: it may fall, causing seri-
ous injury and damage to the projector.

• Place the projector within a slope of ±15˚. Slanting
the projector more than ±15˚ may cause trouble or
explosion of the lamp.

• Do not place the projector near air-conditioning unit
or heater to avoid hot air to the exhaust and venti-
lation hole of the projector.
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Overview of the projector

RGBLAMP

TEMP

CARD

SOURCE MENU

ENTER

VOL

VIDEO

PC CARD

handle
Hold here to carry this projector.

remote control sensor (Front / Rear)

input source (RGB, VIDEO, PC CARD)
Use to select the input source you wish to watch. You can select PC CARD when 
the CARD indicator ON.

menu
Use to project menu display. 

direction

+, -
Press to turn the volume up or down.  During playback 
of PC card, use to select group of the PC card.

 release button
Press to adjust the angle of projection.  See page 11.

exhaust slits
PC card eject
Press to eject the PC card.  See page 23.

enter
Use for MENU setting. See page 17. 

indicators

Normal On Menu On PC card

Adjust FINE (-) Set item Select previous image (Left)

Adjust FINE (+) Set item Select next image (Right)

– Select item (up) Select INDEX or FILE

– Select item (down) Select INDEX or FILE

POWER(  ) LAMP TEMP CARD Condition
Steady red Stand-by.
Steady green Brinking green Power is TMON∫.

} Steady green
Steady green Steady green Blinking red Abnormal temperature warning (high temperature).*1
Steady red Steady red Abnormal temperature-OVER (high temperature).

The source lamp will be also turned off.
Steady green Blinking red /green Lamp duration warning. (Lightning duration total about 1,500 hours.) *2
Steady red Steady red Lamp duration-OVER. (Lightning duration total about 2,000 hours.)
Steady green Steady green Steady green PC card inserted, off then no PC card.

focus ring
Use to adjust the focus by turning it. See page 16.

zoom ring
Use to magnify (or reduce) by turning it. See page 16.

PC card slot
This is where you insert the PC card. See page 23.

PC card slot cover button
Press down to open the PC card slot.  See page 23.

power
Use to turn the projector on or off when MAIN POWER is on.  To turn the projector off, press 
this button twice.
Important:
When the LAMP indicator blinks in green, the power switch cannot be used to switch 
“ON” and “OFF.” Begin operation only after the indicator has stopped blinking. 
See indicator table below for more information.

*1 : In the condition, the sign of “TEMP!!” blinks red on the screen.
*2 : When the lamp has been used for about 1,900 hours, the message “LAMP!!” will appear on the screen.
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PC analog RGB input
Use to input video signals (analog
RGB) of a personal computer.

(Pin assignment of Mini D-SUB 15P jack)

PIN NO. SPEC PIN NO. SPEC

1 R(RED)/CR 9 –
2 G(GREEN)/Y 10 GROUND
3 B(BLUE)/CB 11 GROUND
4 GROUND 12 –
5 GROUND 13 HD/CS
6 GROUND 14 VD
7 GROUND 15 –
8 GROUND

RS-232C input
Use to control the projector with the
personal computer, or control the per-
sonal computer with remote control. Use
the provided RS-232C cable (Mini DIN
8P– D-SUB 9P) for the connection.
PIN NO. NAME I/O

1 TXD IN
2 RTS IN
3 DTR IN
4 GND –
5 CTS/5V IN/OUT
6 DCD/CLOCK OUT
7 RXD OUT
8 RI/DATA OUT

power jack
See page 11.

MAIN power
I  : ON
O : OFF

RS-232 input (Mini DIN 8P)
Use to connect with personal computer when 
using the remote control as mouse, or control
the projector with the personal computer.

line output (stereo mini jack)
Use to output PC audio if the PC has a 
live-level input, or Audio input.

line input (stereo mini jack)
Use to input PC audio signals. See pages 13, 14.

PC analog RGB input (mini D-SUB 15P)
Use to input RGB signal from PC or component 
signal from DVD etc.  See pages 12 - 14.  

video/audio input
Use to input video and 
audio. See page 12.

PC analog RGB output
 (mini D-SUB 15P)
Use to output RGB signal from RGB 
input. See pages 12 - 14.

LINE-OUTRGB-OUT RGB-IN

S-VIDEO VIDEO
INPUT

L-AUDIO-R

LINE-IN RS
-2

32
C

(MONO)

LINE-OUTRGB-OUT RGB-IN

S-VIDEO VIDEO
INPUT

L-AUDIO-R

LINE-IN RS
-2

32
C

(MONO)

Bottom side

filter cover

adjustment foot (up and down)

adjustment foot (right and left)

 Front

lamp lid
Caution:
Do not replace the lamp right after using 
the projector. The lamp is very hot. 

Left side

1 5

11 15
12

6 8

53
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Overview of the remote control

card auto play 
Press to start auto play function of the 
PC CARD. See page 24. 

The buttons with *mark work as same 
as the buttons on the projector.

PC card release
Press this button to be able to eject PC 
card. Make sure to press this button all the 
time to eject the PC card. See page 23. 

* input source

still
Use to freeze the image. See page 22.

* power

right click
This operates in the same way as the right 
button on the computer mouse. See page 31.

* direction

auto position
Use to adjust the position of Personal 
computer image. See page 16.

* +, - (volume)

* menu

mouse pointer
Use to move the cursor on the image, 
instead of the computer mouse. See 
page 31.

* enter
ENTER

R-CLICK

LASER

POWER

RGB VIDEO PC CARD

AUTOPLAYRELEASE
AUTO

POSITION

MENU

STILL

VOLUME

EXPAND

laser
Pressing the button emits laser beam. 

expand
Use to expand the image. See page 22. 

left click
This operates in the same 
way as the left button on 
the computer mouse. See 
page 31.

About laser beam
This remote control is the class 2 (max. output 1mW
laser diode 645nm) laser equipment.

LASER RADIATION
DO NOT STARE INTO BEAM

WAVE LENGTH : 645nm
MAX OUTPUT : 1mW
CLASS II LASER PRODUCT

CAUTION

CAUTION :
Pressing the LASER button provided remote con-
trol emits laser beam. Do not look into the beam
light directly. Do not point the laser beam to people.
Looking the laser beam directly may lose eyesight.
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Battery installation
Use two AA size batteries.
1. Remove the back cover of the remote control by pushing the battery compartment door in the direction of the

arrow.

2. Load the batteries making sure that they are positioned correctly (+ to +, and - to -).

3. Replace the back cover.

Important:
• Do not use a new battery with an old one.
• Load batteries in the correct position.
• Do not heat, take apart, or throw batteries into fire.
• Do not try to recharge batteries.  Do not use rechargeable batteries.
• If the alkaline solution of alkaline batteries comes in contact with your skin or clothes, rinse with water.  If

the solution comes in contact with your eyes, rinse them with water and then consult your doctor.

Operation area
The range for operation is about 10m when the remote control points to the projector.  The distance to the screen
back to the projector must be less than 7m.  Depending on the type of the screen, the distance is different.

Important:
Avoid the direct sunlight or fluorescent light to the remote control sensor. Also keep the distance of more than 2 m
between the remote control sensor and fluorescent lamp.  The remote control may not work correctly.

20˚

15˚

20˚

15˚

30˚30˚

20˚ 20˚

1 2 3
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Preparing the projector for operation
Orientation of the projector
Picture size can be set by changing the distance between the screen and the projector.
Front projection To find the approximate distance

between the projector and screen:
Multiply the width of the screen
✕  2.0 (max.) , Multiply the width of
the screen ✕  2.5 (min.).
• Refer to the chart to recom-

mended distances in maximum
zoom and minimum zoom.

SCREEN

Front projection, ceiling mount
For ceiling mount, you need the ceiling mount
bracket. For more detail, ask your dealer.

• For ceiling mount, set IMAGE REVERSE in
INSTALLATION menu to MIRROR INVERT. You
can not use KEYSTONE when IMAGE RE-
VERSE is inverted.  See Page 18.

• Projected images may appear darker when the
unit is used as a ceiling installation than when it
is used in the tabletop position. This does not
signify a product malfunction.

Rear projection
Ask a specialist for installation.  For more detail, ask
your dealer.

SCREEN

• For rear projection, set IMAGE REVERSE in
INSTALLATION menu to MIRROR.  See Page 18.

Caution:
• Placing the projector on a carpet reduces ventila-

tion from the fan on the bottom and might cause
problems. Place a hard board or similar item
under the projector to facilitate ventilation of the
unit.

• Place the projector more than 20 in. from the wall
to prevent blocking the intake, exhaust slots and
ventilation of this projector because hot air comes
out of it.

• Do not use the projector under the following
circumstances, which may cause fire or electric
shock.
• in a dusty or humid place
• while the projector is lying sideways or upside

down.
• near a heater
• in a kitchen or oily, smoky or damp place
• in direct sunlight
• with high temperature, such as the closed car
• where the temperature is lower than 41°F or

higher than 95°F

Important:
• Do not put stress on the lens or focus ring, as this

may damage them.
• Keep your room dark while using the projector. The

image cannot be seen clearly in a bright place.

L (between the screen and the 
     head of the projector)

screen

• The above numbers are the design numbers, and may be slightly different from the actual numbers.

Diagonal size
 (inch)
23 "
40 "
60 "
80 "

100 "
150 "
200 "
245 "

Height inches
 (inch)
13.8 "
24 "
36 "
48 "
60 "
90 "
120 "
147 "

Width feet
 (inch)
18.4 "
32 "
48 "
64 "
80 "
120 "
160 "
196 "

Screen Distance from screen (L) / (approximate)
Maximum

zoom (min.)
(cm)

–
155
236
317
399
602
805
988

(cm)
112
201
305
410
513
774

1034
–

(inch)
–

61.0 "
92.9 "
125 "
157 "
237 "
317 "
389 "

(inch)
44.1 "
79.1 "
120 "
161 "
202 "
305 "
407 "

–

Minimum
zoom (max.)
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Adjusting the angle of projection
Screen on a flat wall with a 90 degree angle to the floor
by adjusting two Adjustment feet on the bottom of the
projector.  If the angle cannot be corrected by them,
adjust the height and angle of screen.

1. Lift the projector to the right angle.
2. Press the release button for angle adjustment to take

the Adjustment foot (up and down) out of the pro-
jector.

3. Release the button and keep your hands away from
the projector.

4. Turn the foot to right or left to adjust for proper
angle.

After using the projection,
5. Press the release button to take the projector down

slowly with holding it.

When the left and right angles are different
Adjust the angles with adjustment feet (right and left),
which are on the bottom of the projector. When ship-
ping the projector at first, the Adjustment feet are cov-
ered with sponge to be parallel on a flat surface. Re-
move the sponge to adjust the Adjustment feet lower.
Do not lose the sponge.

Important:
The image becomes trapezoid shape when the screen
or project is not level.  Use KEYSTONE in INSTAL-
LATION menu to adjust, however, the circumference
of the image may not be focused. See page 18.

• Screen on a flat wall with a 90˚ angle to the floor.
• Align projector to produce a full screen display as

illustrated on page 10.
• Distance from projector to screen must be

compatible with screen size chart on page 10. Note
distance from screen chart.

Getting ready for projection
1. Connect the power cord provided to the projector.
2. Connect the power cord to the wall outlet.

3. Take off the lens cap.

Warning:
• Do not look directly into the lens when projector is

“ON”.
• The lens cap is for protecting the lens.  If you leave

the power on with the cap on, the cap may be warped.
Please remove the lens cap when you turn the power
on.

• A three-pin grounding type power plug is used with
the projector. Do not remove the grounding pin on
the power plug. If you are unable to insert the plug
into the outlet, contact your electrician to replace
your obsolete A/C outlet.

• The supplied power cord is used for 120V only. Never
connect to any outlet or power supply having a dif-
ferent voltage or frequency. If you connect to the
power supply having a different voltage, please use
the appropriate power cord.

• Do not place an object on the power cord and keep
the projector away from heat source to avoid break-
ing the power cord. A broken power cord can cause
fire or electric shock.

• Do not revise or alter the power cord otherwise it
may cause fire or electric  shock.
Contact your dealer if the cord is broken.

Caution:
• Plug in firmly and unplug by holding the plug, not

by pulling the cable out.
• Do not plug in or out  with wet hands.  It may cause

an electric shock.

Plug in the provided
power cord directly.

ground
terminal

Adjustment foot
(up and down)screen
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Cables and adapters
To connect personal computers to this projector, the following cables and adapters are necessary.  The overview
might be different from the picture below.

RGB cable for PC  (mini D-SUB 15P plug)

.

Note: The pins numbered 9, 12 and 15 are not connected.

MAC adapter for RGB cable
 (mini D-SUB 15P plug - D-SUB 15P plug)

Basic connections
This projector can be connected to equipment such as VCRs, video cameras, videodisc players, and personal comput-
ers having analog RGB input.

Important:
• Make sure that your equipment is turned off before connection.
• Match the color of video and audio plugs on the AV cable with each terminal.
• Plug in firmly and unplug by holding the plug, not by pulling the cable out.
• If connected units are set too close to one another, the image may be affected.
• Refer to the owner's guide of each component for details of connections.

Projector + AV equipment
Make sure that your equipment is turned off before connection.

Important:
S-video signals take priority over video signals. If you input both S-video signals and normal video signals at the
same time, the normal video input automatically is inhibited.

to audio
output

to video
output

to S-video
output

Connect either one of these.

VCR, others

to audio input

to S-video 
input

to video input

Projector + DVD player
Some DVD players have output terminal for 3 line fitting (Y, CB,
CR).  When connecting them to the projector, connect to RGB IN
of the projector.  In this case, set “Y, CB, CR” for RGB/Y, CB, CR

setting in SIGNAL menu.

to RGB IN 

G R B 

CB Y CR 

H
D

/C
S

V
D

 

DVD player

No connection

• Use mini D-SUB 15 pin-BNC conversion cable for connection.
• Some DVD player may not project the image correctly.

PIN NO.
1
2
3
•

•
•

13
14
15

PIN NO.
1
2
3
•

•
•

13
14
15

MINI D-SUB 15P MINI D-SUB 15P

MINI D-SUB 15P D-SUB15P

1
2

3
4

5
6

O
N

D
IP

Note: Set the dip switch to the appropriate position.

%

Display Resolution Dip switch
mode 1 2 3 4 5 6

13 inch 640 ✕  480 ON ON OFF OFF OFF OFF
16 inch 832 ✕  624 OFF ON OFF ON OFF OFF
19 inch 1024 ✕  768 OFF ON ON OFF OFF OFF
21 inch 1152 ✕  870 ON ON ON ON OFF OFF
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Projector + IBM PC or IBM PC compatibles
Make sure that your equipment is turned off before connection.

Important:
• Connectors or analog RGB output adapters may be necessary depending on the personal computer connected to

this projector.  Please contact your dealer.
• The audio input for a personal computer is the stereo mini-jack. There are some personal computers that have

different types of audio outputs or none at all. Please ask your dealer for details.
• For connection details, refer to the owner's guide of each component.

to monitor 
port

to monitor port

desktop computer

notebook computer RGB cable for PC

PC audio 
cable (option)to PC audio 

output to RGB IN

to LINE IN

When outputting to both a PC monitor and the projector

to monitor 
port

desktop computer

PC audio 
cable (option)

RGB cable for PC

RGB cable
(option)

to LINE IN

to PC audio 
output

to PC 
monitor

to RGB  IN

to RGB OUT
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Projector + Macintosh
Make sure that your equipment is turned off before connection.

Important:
• A monitor output adapter is necessary for a Macintosh if it has no video port. Please contact your dealer.
• If you use the MAC adapter for RGB cable provided, set the dip switch to the appropriate position. See page 12.
• Connectors or analog RGB output adapters may be necessary depending on the personal computer connected to

this projector.  Please contact your dealer.
• The audio input for a personal computer is the stereo mini jack. There are some personal computers that have

different types of audio outputs or none at all. Please ask your dealer for details.
• For connection details, refer to the owner's guide for each component.
• When outputting to both a PC monitor and the projector, use an Apple Macintosh monitor or multiscan monitor

corresponding to Composite Sync.

to video port

to video port

desktop computer

Power Book MAC adapter for
RGB cable

RGB cable for PC

to LINE IN

to PC audio 
output

to RGB IN

1
2

3
4

5
6

O
N

D
IP

PC audio 
cable (option)

When outputting to both a PC monitor and the projector

to video port
desktop 
computer

MAC adapter for 
RGB cable

Monitor 
Conversion
adapter (option)

RGB cable for PC

Monitor cable
(option) to LINE IN

to PC audio 
output

to PC
monitor

to RGB IN

to RGB OUT

1
2

3
4

5
6

O
N

D
IP

PC audio 
cable (option)

Basic connections (continue)
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To operate projector power ON
Numbers 1 - 9 correspond to the instruction numbers below.

Important:
• A darkened image may be seen right after pressing

the POWER button  due to warming up of this pro-
jector. While warming up, no other commands can
be accepted.

• When the lamp indicator is blinking red, the ser-
vice life of the lamp is about to end.  Replace the
lamp. See pages 32 and 36.

• The picture might not be of optimum performance
in extreme hot or cold conditions. (The projector is
not malfunctioning.)

4.  Select the desired external input source by using
the RGB or VIDEO button.

• The projector automatically selects the appropriate
signal format. The selected signal format is displayed
on the SIGNAL menu.

• When selecting the RGB input, the image may
flicker.  Press the $ or % button to adjust the im-
age.

• Press the PC CARD button to see the PC CARD im-
ages.  (You cannot select it when CARD indicator is
not lighting up.)

1. Turn on the equipment connected to the projector.

2. Put the projector into standby mode by pressing the
main power switch. The POWER indicator lights up
red.

3. Turn the projector on by pressing the POWER but-
ton.
The light source lamp starts warming up, eventu-
ally turn on.  In cases where light source lamp does
not come on, wait for one minute before switching
power on again.
• If the main power switch to the unit is turned

off within two minutes of turning off the light
source lamp, power will not be applied to the
lamp for one minute the next time the main
unit power switch is turned on. When this
happens, the indicator lamp will blink for one
minute.

92

LINE-OUTRGB-OUT RGB-IN

S-VIDEO VIDEO
INPUT

L-AUDIO-R

LINE-IN RS
-2

32
C

(MONO)

7 83

4

5
6

RGBLAMP

TEMP

CARD

SOURCE MENU

ENTER
VIDEO

PC CARD

VOL

condition
indicator LAMP POWER

stand-by - red
when light source lamp is on green green

when light source lamp does not light up red-
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AUTO POSITION button
When the source is selected to RGB and the image is
not in the right place, set to display as at the
brightest signal as possible, then press the AUTO
POSITION button on the remote control. If the image
is still not in the right place.
• Set screen to the brightest display as possible

(e.g., full-screen display of the “Trash” window)
before deploying the automatic adjustment
function.

• If the screen saver is running, turn off the screen
saver before using the automatic adjustment
button.

5. Adjust the focus with the focus ring by turning it.

6. Adjust the image size with the zoom ring by turn-
ing it.

The volume from the speaker
Press the volume + or – button to change the volume
from the speaker.

• The volume buttons do not work when MENU se-
lection bar or MENU is displayed.

• The volume buttons do not work when the source is
selected to PC CARD.

Turning off the projector
7. Press the POWER button.

The message “POWER OFF? YES : PRESS AGAIN”
appears on the screen.
• To exit from this mode,  press any button except

POWER, LASER, mouse pointer, R/L-click,
STILL and VOLUME + and - button.

8. Press the POWER button again.
The light source lamp will be turned off.
Pressing the POWER button again will shut off the
light source lamp, but the exhaust fan continues to
operate for 120 seconds to cool down the light source
lamp and LCD panels. In this time, the lamp indica
tor will be turned off from flashing.

9. Turn off the main power switch. When turning off
the main switch, the POWER indicator turns off.

• In cases where the main power switch is acciden-
tally turned off when either the intake/exhaust
fan or the power source lamp is in operation, allow
the unit to cool down for 10 minutes with the
power turned off. Repeat step 3 when turning on
the power source lamp. If the lamp does not turn
on immediately, repeat this step two or three
times. Replace the lamp if it should still fail to
turn on.

Caution:
• When you have finished using this equipment, wait

120 seconds for the exhaust fans to stop. Then turn
off the main switch and unplug the power cable from
the wall outlet, for safety purposes.

• After the lamp is turned off,  the lamp cannot be
switched on again for 60 seconds as a precaution-
ary measure. It will take another 60 seconds before
the lamp indicator goes off. If you wish to turn on
the projector again, wait until the indicator is off
then press the POWER button.

• The exhaust fan runs faster automatically when the
temperature around the projector becomes high.

• When the temperature around the projector becomes
much higher, the sign of “TEMP!!” blinks red on the
screen. If the temperature stays in high, the lamp will
be shut off automatically .

The projector automatically shuts off when the
lamp is used up in about 2,000 hours and not used
until  lamp replacement.

wide

zoom ring
tele

far

near

focus ring

30

To operate projector power ON (continue)
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Basic operation
Several settings can be adjusted using Menu.

EXAMPLE: Auto power off time setting

1.  Press the MENU button.

2.  Press the $ or % button to select OPTION menu.

3.  Press the ENTER button (or { or } button).

4.  Press the{ or } button to select AUTO POWER
OFF.

5.  Press the $ or % button to adjust auto power off
time.

6.  Exit the menu system by pressing the MENU but-
ton several times.

• If the menu operation is not working, simultaneously
press the MENU and POWER buttons.

• The input source can not be changed when the
MENU selection bar or MENU is displayed.

• The settings with 2 mark, you should press the
ENTER button after selecting.

Menu operation
PICTURE    CONTRAST ± 10

BRIGHTNESS ± 10
COLOR TEMP STANDARD

HIGH
LOW
USER

TINT ± 10
COLOR ± 10

SHARPNESS ± 10

CONTRAST R ± 10
CONTRAST B ± 10

BRIGHTNESS R ± 10
BRIGHTNESS B ± 10

PRESENTATION    ZOOM MODE 1 - 4
POSITION 1 - 4

AUTO SLIDE TIME 3 - 99sec
REPEAT ON/OFF

INSTALLATION    IMAGE REVERSE OFF/MIRROR/INVERT/MIRROR INVERT
KEYSTONE 0˚/3˚/6˚/9˚/12˚/15˚

AUTO POWER ON ON/OFF
TEST SIGNAL OFF/1 - 4

OPTION    SXGA PICTURE MOTION/STILL
MENU POSITION UPPER LEFT/LOWER RIGHT

AUTO POWER OFF OFF/5/10/15/30/60min.
VIDEO SIGNAL AUTO/NTSC/PAL/SECAM/4.43NTSC/PAL-M/PAL-N/PAL-60

LANGUAGE /English/Español/Deutsch/Français/Italiano/

SIGNAL    AUTO AUTO/USER1/USER2
HORIZ.POSITION 0 - 999
VERT.POSITION 0 - 999

FYNE SYNC. 0 - 32
TRACKING 0 - 9999
RGB INPUT

HOLD

USER

RGB/YCBCR,YPBPR

BEGIN -1 - -99
END 1 - 99

CLAMP POSITION 0 - 63
CLAMP WIDTH 0 - 63
HORIZ.PIXELS 0 - 9999

VERT.LINES 0 - 9999
PLL AUTO/FAST/NORMAL/SLOW

VERT.SYNC. AUTO/ON/OFF
SQUEEZE ON/OFF

MEMORIZE  
DELETE  
RESET  

ON  
OFF

AUTO

USER1/USER2
USER1/USER2

*
*

*

*
*

*
*
*
*

* : Setting range is different according 
     to the type of the signal.
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1  PICTURE
CONTRAST ........ Adjusts the picture contrast. The contrast becomes higher

as the number increases.
BRIGHTNESS .... Adjusts image brightness. The image becomes brighter as

the number increases.
COLOR TEMP .... Adjusts color temperature.
TINT .................... Adjusts the color balance in the image.  The color balance

of the image shifts green as the number increases and
shifts to purple as the number decreases (only when
NTSC or 4.43 NTSC is selected).

COLOR ................ Adjusts the color intensity of the image (only when NTSC, PAL, SECAM or 4.43 NTSC is
selected).

SHARPNESS ...... Adjusts the picture sharpness. The sharpness becomes sharper as the number increases
(only when the source is selected to VIDEO).

2  PRESENTATION
This menu appears when either the display enlargement and PC card play
functions are used.
ZOOM MODE ..... Selects the desired type of expand mode, type1, 2, 3 or 4

(Actual size display).
POSITION .......... Selects the desired position of the sub image in expand

mode.
AUTO SLIDE
TIME ................... Sets the length of time before the image switches to the next image in PC CARD automatic

playback mode.
REPEAT .............. Sets to repeatedly playback the PC CARD presentation.

3  INSTALLATION
IMAGE REVERSE Use to reverse or invert the projected image. MIRROR is

used for rear projection.  MIRROR INVERT is effective
when the projector is ceiling-mounted.

KEYSTONE ........ Adjusts keystone correction of the image. If the image is
keystoned, select the approximate setting. For normal
use, select 0˚. You can use it only when IMAGE REVERSE
is OFF.

AUTO POWER ON ....To select whether to boot up automatically when the power
is turned on by a breaker. In this case, the main power of the projector has to be ON.  Set this
when the projector is hanging on the ceiling.
• The projector is in stand-by mode when the lamp does not come on. In this case, use the

remote control to turn on the lamp.
TEST SIGNAL .... Use to display the built-in test patterns on the screen.

• The display will disappear when the setting is OFF or press the button except MENU,
{ ,}, STILL, LASER, mouse pointer and R/L-click.

4  OPTION
SXGA PICTURE . Select MOTION when motion images are mainly

projected.  Select STILL when still images such as PC-
CARD images are mainly projected.  It works only when
inputting personal computers of SXGA signals.

MENU POSITION . Use to select the position where the menu is displayed
(upper left or lower right on the screen).

AUTO POWER OFF ..Use to select the length of time the projector switches to
standby when there is no input signal selected source.
Select OFF to cancel this function.

VIDEO SIGNAL . When AUTO is set, the appropriate video format is automatically selected according to the
input signal. If the image does not appear correctly, select the desired video format
manually. Adjust the unit to the appropriate format when the unit either is not projecting
normally in auto mode or is inputting PAL-M/PAL-N signals.

LANGUAGE ....... Use to select the language for the projector display such as menu. (  / English / Español
/ Deutsch / Français / Italiano / )

Menu setting (continue)
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5  SIGNAL
AUTO .................. Use to select AUTO, USER 1 or USER 2.
HORIZ. POSITION ....Use to adjust the horizontal position of the image.
VERT. POSITION ..... Use to adjust the vertical position of the image.
FINE SYNC. ....... Use to synchronize the projector with PC input signals so

that the image is not blurred.

TRACKING ......... Use to avoid image noise such as wide stripes.
RGB INPUT ........ The unit adjusts itself automatically when connected to

either DVD players with a component video output
terminal (Y, CB, CR or Y, PB, PR) or equipment with HDTV
signal output capabilities. In cases where the unit is
connected to equipment that include an RGB output
terminal and which output HDTV signals, adjust the unit to RGB mode.

HOLD .................. Adjusts the image which upper side is awry.

6  SIGNAL  - USER (Normally, there is no need for adjustments.)
CLAMP POSITION/
CLAMP WIDTH ......... If you use a PC video card or something similar, the

brighter colors of the projected image may become blurred.
In this case, adjust CLAMP POSITION or CLAMP
WIDTH.

HORIZ. PIXELS .... Use to adjust the width of the image. The image size grows
wider as the number increases. (Adjust to the horizontal
pixels of inputting signal for normal setting.)

VERT. LINES ..... Use to adjust the height of the image. The image size
grows higher as the number increases. (Adjust to the vertical lines of inputting signal for
normal setting.)

PLL ...................... Use to adjust the image which upper side is awry.  Select AUTO for normal setting.
VERT. SYNC. ..... Use to adjust the image when its motion does not run naturally.  Select AUTO for normal

setting.
SQUEEZE ........... Set to ON when displaying DVD discs which are recorded as the squeezed image (in right

and left direction).
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Adjustment from personal computer
Although this projector sets proper signal settings set
automatically for the image signal from personal
computers. But at times, there can be some
diferences in timings.  In this case, press AUTO
POSITION button.  If the images are still not pro-
jected correctly, use MENU display to adjust the
projected images from personal computers.
Afteradjustments are made, the new settings can be
saved in user function.

Adjusting the images from personal
computers in MENU display
Adjust as below for the following symptoms.

Image moves to right or left :
Adjust HORIZ. POSITION in SIGNAL menu.  Press
the % button to move the image to left.  Press the $
button to move the image to right.

Image moves to up or down :
Adjust VERT. POSITION in SIGNAL menu.  Press
the % button to move the image to upward.  Press
the $ button to move the image to down.

Image flickers / Image is out of focus :
Adjust FINE SYNC. in SIGNAL menu.
Wide stripes appear :

Adjust CLAMP POSITION or CLAMP WIDTH of
each menu in SIGNAL - USER menu.

Noise etc. appears on right or left side of image:
Adjust HORIZ. PIXELS of the menu in SIGNAL -
USER menu.

Noise etc. appears on top or bottom part of image :
Adjust VERT. LINES of the menu in SIGNAL -
USER menu.

Top part of image curves :
Change the setting of HOLD in SIGNAL menu or

PLL in SIGNAL - USER menu.
HOLD ...Select ON, and adjust BEGIN or END for

image which top part is the least curved.
PLL .......Select FAST, NORMAL, or SLOW for

image which top part is the least curved.
Select AUTO for normal setting.

Image does not move naturally :
Adjust VERT. SYNC. of the menu in SIGNAL - USER
menu.  Select AUTO for normal setting.

• Do not change each menu setting in SIGNAL -
USER menu for normal setting.

Memorizing the setting
1. Select MEMORIZE in SIGNAL menu, and press

the ENTER button.
2. Press the $ or % button to select the memory

which you wish to record (USER 1 or USER 2).
3. Press ENTER button.

Initializing the setting which has been changed
Select RESET in SIGNAL menu, and press ENTER
button.
•  When initializing, selection buttons will not work

for about 2 - 18 seconds.

Seeing images in recorded setting.
Select AUTO in SIGNAL menu, and press the$ or
% button to select the memory (USER1 or USER2).

Resetting the recorded setting
1. Select DELETE in SIGNAL menu, and press

ENTER button.
2. Press the$ or % button to select the memory

which you wish to reset (USER 1 or USER 2).
3. Press ENTER button

The recorded setting will be reset.

The simple way of adjustment
1. Select HORIZ. POSITION in SIGNAL menu.
2. Press the$ or % button to adjust the horizontal

start position (the left end).
3. Select TRACKING in SIGNAL menu.
4. Press the$ or % button to adjust the horizontal

end position (the right end).
5. Repeat steps 1 to 4 for fine adjustment.
6. Select VERT. POSITION in SIGNAL menu.
7. Press the$ or % button to adjust the vertical

start position (the top end).

Picture adjustment
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Specification of RGB signals in each computer mode of the projector

Signal mode resolution horizontal Vertical Normal Native
 (H x V) frequency (kHz) frequency (Hz) (H x V)  (H x V)

TV60 – 15.73 59.94 1024 x 768 640 x 438
TV50 – 15.63 50.00 1024 x 768 680 x 544
HDTV – 33.75 60.00 1024 x 576 (882 x 496)
PC98 640 x 400 24.82 56.42 1024 x 640 640 x 400
CGA70 640 x 400 31.47 70.09 1024 x 640 640 x 400
CGA84 640 x 400 37.86 84.13 1024 x 640 640 x 400
CGA85 640 x 400 37.86 85.08 1024 x 640 640 x 400
VGA60 640 x 480 31.47 59.94 1024 x 768 640 x 480
VGA72 640 x 480 37.86 72.81 1024 x 768 640 x 480
VGA75 640 x 480 37.50 75.00 1024 x 768 640 x 480
VGA85 640 x 480 43.27 85.01 1024 x 768 640 x 480
SVGA56 800 x 600 35.16 56.25 1024 x 768 800 x 600
SVGA60 800 x 600 37.88 60.32 1024 x 768 800 x 600
SVGA72 800 x 600 48.08 72.19 1024 x 768 800 x 600
SVGA75 800 x 600 46.88 75.00 1024 x 768 800 x 600
SVGA85 800 x 600 53.67 85.06 1024 x 768 800 x 600
XGA43i 1024 x 768 35.52 86.96 1024 x 768 1024 x 768
XGA60 1024 x 768 48.36 60.00 1024 x 768 1024 x 768
XGA70 1024 x 768 56.48 70.07 1024 x 768 1024 x 768
XGA75 1024 x 768 60.02 75.03 1024 x 768 1024 x 768
XGA85 1024 x 768 68.68 85.00 1024 x 768 1024 x 768
SXGA70a 1152 x 864 63.85 70.01 1024 x 768 1024 x 768
SXGA75a 1152 x 864 67.50 75.00 1024 x 768 1024 x 768
SXGA85a 1152 x 864 77.49 85.06 1024 x 768 1024 x 768
SXGA60a 1280 x 960 60.00 60.00 1024 x 768 1024 x 768
SXGA75a 1280 x 960 75.00 75.00 1024 x 768 1024 x 768
SXGA43i 1280 x 1024 46.43 86.87 960 x 768 1024 x 768
SXGA60 1280 x 1024 63.98 60.02 960 x 768 1024 x 768
SXGA75 1280 x 1024 79.98 75.03 960 x 768 1024 x 768
SXGA85 1280 x 1024 91.15 85.02 960 x 768 –
UXGA48i 1600 x 1200 62.50 96.08 1024 x 768 –
UXGA60 1600 x 1200 75.00 60.00 1024 x 768 –
UXGA65 1600 x 1200 81.25 65.00 1024 x 768 –
UXGA70 1600 x 1200 87.50 70.00 1024 x 768 –
UXGA75 1600 x 1200 93.75 75.00 1024 x 768 –
UXGA80 1600 x 1200 100.00 80.00 1024 x 768 –
UXGA85 1600 x 1200 106.25 85.00 1024 x 768 –
MAC13 640 x 480 35.00 66.67 1024 x 768 640 x 480
MAC16 832 x 624 49.72 74.55 1024 x 768 832 x 624
MAC19 1024 x 768 60.24 75.02 1024 x 768 1024 x 768
MAC21 1152 x 870 68.59 74.96 1024 x 768 1024 x 768
HP75 1024 x 768 62.94 74.92 1024 x 768 1024 x 768
HP72 1280 x 1024 78.13 72.00 960 x 768 1024 x 768
SUN66a 1152 x 900 61.85 66.00 984 x 768 1024 x 768
SUN76a 1152 x 900 71.81 76.63 984 x 768 1024 x 768
SUN66 1280 x 1024 71.68 66.68 960 x 768 1024 x 768
SUN76 1280 x 1024 81.13 76.11 960 x 768 1024 x 768
SGI72 1280 x 1024 76.92 72.30 960 x 768 1024 x 768
SGI76 1280 x 1024 82.00 76.00 960 x 768 1024 x 768
IBM60 1280 x 1024 63.42 60.00 960 x 768 1024 x 768

• *1 : As a result of line reduction in the projection
process with the computer models listed above, lines
and portions of characters found in the original data
may be missing from the projected image.

• When the ZOOM MODE of PRESENTATION menu is set
to 4, by pressing the EXPAND button on the remote con-
trol, it will switch to the screen displaying the picture as
its original size (real screen display).  In the real screen
display, pictures will be black-framed when picture reso-
lution is lower than 1,024 ✕  768.

Important:
• Some computers may not be compatible with the projector.

• The projector's maximum resolution is 1,024 ✕  768 pixel.
It may not be displayed correctly for the pictures of higher
resolutions than 1,024 ✕  768.

• The picture with a SYNC on G (Green) signal may
jitter.

• The picture with a SYNC on G (Green) signal may be
tinged with green.

• If the resolution and frequency of your computer are not
shown on the table., change the resolution of your com-
puter. You may find the compatible resolution and fre-
quency.

• Set the RGB/Y, CB, CR in SIGNAL menu to RGB, when
inputting the HDTV signal as RGB signal.

*1
*1
*1
*1
*1
*1
*1
*1
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Expand
By pressing the EXPAND button on the remote con-
trol, you can view the detailed image of the picture.

Setting the Expand mode
1. Press the MENU button once to display the on-

screen menu.

2. Press the $ or % button to select PRESENTATION
menu.

3. Press the ENTER button.

4. Press the{ or } button to select ZOOM MODE or
POSITION.

5. Press the $ or % button to set the ZOOM MODE
or POSITION.

6. Press the MENU button twice to exit the menu sys-
tem.

Normal picture

Actual size picture

Zooming picture

(ZOOM MODE1)

(ZOOM MODE4)

Zooming picture

(ZOOM MODE3)

(ZOOM MODE2)

ZOOM MODE

Zooming picture

Normal 
picture

Using the Expand mode
1. Press the EXPAND button.

A red frame indicating EXPAND area will appear.
• You can magnify different areas of the active pic-

ture by pressing the {, }, $ or % button.
• You can change the magnification of the zoomed

area by pressing the + or - button.
2. Press the EXPAND button again.

• Display enlargement does not work with
video input or S-video input.

• In EXPAND mode, do not display the test pattern.
• The red frame indicating EXPAND area will

disappear when the cursor is selected.

Indication Mode 4 (actual size display)
• Pressing the $, % buttons is for adjusting fine

adjust.
• The expanding rate cannnot be changed either

pressing + or - button.

Advanced feature for presentation
Still
How to stop the picture temporarily (still picture)
1. Press the STILL button on the remote control.

The picture will stop temporaly.

To stop still picture.
2. Press the STILL button on the remote control

again.
• To release the still picture, any buttons also can

be used.
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PC-CARD
The projector can play back an image by using the PC-
CARD.

Using the PC-CARD
Use only the flash memory card of PCMCIA•ATA com-
patible type II.
• Due to PC-CARD type, some images can not be prop-

erly recorded.  Please contact your dealer.

Setting up the PC-CARD
1. Set the projector into standby mode by pressing the

main power switch. The POWER indicator lights up
red.

2. Press down the PC card slot cover button to open
the PC card slot cover.

3. Make sure the PC card is
going to be inserted in
right side.  The PC card
indicator will illuminate.

When the input source is set to
PC CARD, do not remove the PC card. The projector
may not work correctly.

Removing the PC-CARD
1. Press the RELEASE button on the remote control.

PC card eject icon will be displayed on the right
end of the screen.
The PC card indicator will auto turn off on the
projector.

2. Press down the PC card slot cover button and press
the eject button simultaneously.

3. Remove the PC card from the PC card slot.

• Upon removing a PC card, wait at least 2 seconds
before inserting another.

• The following manufacturer’s PC cards have been
confirmed to operate within this projector.
EPSON, TDK, Logitec, Panasonic, Verbatim, I-O
DATA, HAGIWARA, IBM, Mitsubishi (MF-Series).

Play back
1. Insert the prerecorded PC-card.

2. Press the CARD button.
The PC-CARD index display appears on the screen.

3. Press the $ or % button to select the desired im-
age.
• If the PC-CARD is recorded by using the per-

sonal computer, select the desired group by press-
ing the + or - button.

4. Press the { or } button to enter the image dis-
play mode.

5. Press the $ or % button to display another
image.

6. Press the VIDEO or RGB button to quit the PC-
CARD playback function.

7. Press the RELEASE button on the remote
control.

8. Press the eject button to take the card out.

• During PC-CARD playback, the sound is
switched off.

• Noise may occur momentarily when images are
updated via PC card.

• The images recorded in BMP (not compressed)
will take a long time to playback.

• It takes about 10 seconds to playback JPEG
compressed data.

• When having an access of PC card as you want to
exchage images on PC card, there will be four red
line indicated at the edge of the screen.

• If the PC card is ejected when playing back PC
card, the image will be switched to VIDEO
automatically.

• During PC-CARD playback, if the incorrect
display appears, release and re-insert the PC-
CARD.

Playback picture taken by the digital camera
• The image which has been recorded in PCMCIA/

ATA card, smart media or compact flash can be
played back.  The PC card adapter is required to
playback smart media and compact flash.

• Depending on the type of the digital camera, the
picture will not appear correctly.  Please contact
your dealer.

• PC card recorded by Digital Camera, the picture
will not be displayed on PC-CARD index display.
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PC-CARD (Continue)

To automatically change the image, follow the steps
as shown below.
1. Press the MENU button.

2. Press the $ or % button to select PRESENTATION.

3. Press the ENTER button.

4. Press the { or } button to select AUTO SLIDE
TIME (3 - 99 sec.)

5. Press the $ or % button to set the time for auto
playback.

6. Press the{ or } button to select REPEAT.

7. Press the $ or % button to select ON or OFF.

8. Press the MENU button twice to exit the menu sys-
tem.

9. Press the PC CARD button.

10. Press the $ or % button to select the desired im-
age.

11. Press the AUTO PLAY button on the remote con-
trol.
The image automatically changes according your
setting.

12. Press the AUTO PLAY button on the remote con-
trol to quit the PC-CARD automatic playback func-
tion.

• A gray frame will appear during auto play.
• Button operation will only work when the gray

frame appears on screen. Button operation is not
possible while the red frame is on-screen.

• Auto play can be stopped by pressing the button
except LASER, mouse pointer and R/L-click.

• Auto play cannot be used either during image
enlargement or when menus are displayed.
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Advanced feature with PC
PCV (PC Card Viewer)
PC-CARD viewer (PCV) is a utility software that lets
you record and project an  image to a PC-CARD by us-
ing a personal computer.

Environment
The following system software and hardware are nec-
essary to use the projector.

When you use a Macintosh
• Macintosh series loading 68030 or higher in

CPU and a video card with which more than
256 colors are available

• System7.1 or newer
• More than 8MB of Random-access memory

(RAM) space

When you use Microsoft® Windows®

• Microsoft® Windows® 95 Operating System
(Windows 95) or Microsoft® Windows NT®

Operating System Version 4.0 (Windows NT
4.0) or Microsoft® Windows® Operating System
Version 3.1 (Windows 3.1)  with the CPU
loading 80486SX or higher and a display card
with more than 256 colors are available.

• 16MB or more of RAM available
• We recommend the following hardware.

• 32MB or more of RAM available
• A video display card with full colors are

available

EXPORT LAW ASSURANCES
You acknowledge and agree that the SOFTWARE is subject
to restrictions and controls imposed by the United States
Export Administration Act (the “Act”) and the regulations
thereunder. You agree and certify that neither the
SOFTWARE nor any direct product thereof is being or will
be acquired, shipped, transferred or reexported, directly or
indirectly, into any country prohibited by the Act and the
regulations thereunder or will be used for any purpose
prohibited by the same.

LIMITATIONS OF REMEDIES
Regardless of whether any remedy set forth herein fails of
its essential purpose, in no event will Mitsubishi be liable
to you for any special, consequential, indirect or similar
damages, including any lost profits or lost data arising out
of the use or inability to use the SOFTWARE or any data
supplied therewith even if Mitsubishi or anyone else has
been advised of the possibility of such damages, or for any
claim by any other party.
Some states do not allow the limitation or exclusion of
liability for incidental or consequential damages so the
above limitation or exclusion may not apply to you.
In no case shall Mitsubishi’s liability exceed the price for

the SOFTWARE.

Installation of software
For Windows 95 or Windows NT 4.0
1.  Start up Windows.

2. Insert the Projector driver CD-ROM into your CD-
ROM drive.

3. Start up Program Manager.
Click the [Start] button and select the [Run (R)] com-
mand. Then the [Run] dialog box is displayed.

4. If you inserted the CD-ROM to drive D, type [D:
Win95\Pcv\Us\Setup95] (Windows 95) or [D:
Winnt40\Pcv\Us\Setupnt] (Windows NT) in the
"command line" text box and click the "OK" button.
The letter [D] may be different according to the
drive you use.

5. When the setup program starts up, follow the on-
screen instructions.

6. When the message “Completed” appears on screen,
click the [Finish] button to complete the installation.

• Installation of Microsoft Internet Explorer 3.02 (or
later) is required for optimum unit operation. Use
the Jaaxdist.exe command should the unit appear
to not be performing normally.

For  Windows 3.1
1.  Start up Windows.

2. Insert the Projector driver CD-ROM into your CD-
ROM drive.

3. Select the [Run (R)] command on the icon menu so
that the dialog box [Run] is displayed.

4. If you inserted the CD-ROM to drive D, type
[D:Win31\Pcv\Us\Setup] in the "command line"
text box and click the "OK" button. The letter [D]
may be different according to the drive you use.

5. When the setup program starts up, follow the on-
screen instructions.

6. When the message “completed” appears on screen,
click the [OK] button to complete the installation.

For Macintosh
1. Start up Macintosh.

2. Insert the Projector driver CD-ROM into your CD-
ROM drive.

3. Copy "PCV for Mac” file in the “PCV” folder to
anywhere on the hard disk.
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Advanced feature with PC (Continue)

Starting up PCV (For Windows)
For Windows 95 or Windows NT
1. Start up Windows.

2. Insert the PC card to the PC Card slot on the per-
sonal computer.

3. Start up Program Manager.
Click the [Start] button and select the [Program
(P)]➔ [Pcv]➔ [PCV]command.

For Windows 3.1
1. Start up Windows.

2. Insert the PC card to the PC Card slot on the per-
sonal computer.

3. Double click the [PCV] icon in the PCV folder.

Command reference (For Windows 95)
The command references are as shown below:
File

New presentation .... Create a new presentation.
Open presentation ... Opens an existing presenta-

tion.
Close presentation ... Closes an opened presenta-

tion.
Save presentation .... Saves an opened presentation

using the same name.
Save presentation As... Saves an opened presentation

to a specified name.
Delete presentation . Delete an opened presenta-

tion.
Exit ........................... Exits PCV.

Edit
Cut ............................ Deletes selected image from

the presentation and moves it
to the clipboard.

Copy .......................... Copies selected image data
from the presentation to the
clipboard.

Paste ......................... Pastes image data from the
clipboard into the presentation.

Image
Add image

Image file ............ Inserts image file to an opened
presentation.

Screen capture .... Captures screen and inserts it
to an opened presentation.

Delete image ............ Deletes the selected image
from an opened presentation.

Image information ... Displays information of the
selected image.

View
Tool Bar .................... Shows or hides the toolbar.
Drive Bar.................. Shows or hides the drivebar.
Status Bar ................ Shows or hides the status bar.

Window
Cascade .................... Arranges windows in an over-

lapped fashion.
Tile Horizontal ......... Arranges windows in non-

overlapped horizontal tiles.
Tile Vertical .............. Arrages windows in non-over-

lapped vertical tiles.
Arrange Icons ........... Arranges icons of closed win-

dows.
Windows 1, 2, ........... Goes to specified window.

Help

Help Topics ............... Offers you an index to topics
on which you can get help.

Advanced settings .... Displays a detail setting of
this application.

About PCV ............... Displays the version informa-
tion of this application.

Command reference (For Windows 3.1)
The command references are as shown below:
File

New presentation .... Create a new presentation.
Open presentation ... Opens an existing presenta-

tion.
Close presentation ... Closes an opened presenta-

tion.
Save presentation .... Saves an opened presentation

using the same name.
Delete presentation ... Delete an opened presenta-

tion.
Open image file ........ Import an image from a file.
Exit ........................... Exits PCV.

Edit
Cut ............................ Deletes selected image from

the presentation and moves it
to the clipboard.

Copy .......................... Copies selected image data
from the presentation to the
clipboard.

Paste ......................... Pastes image data from the
clipboard into the presenta-
tion.

Tool
Capture .................... Captures screen and inserts it

to an opened presentation.
Delete image ............ Deletes the selected image

from an opened presentation.
View

Tool Bar .................... Shows or hides the toolbar.
Status Bar ................ Shows or hides the status bar.
Index image size ...... Select the size of index image.

Option
Select card drive ...... Select (or change) the PC-

CARD drive.
Card drive info ......... Display the information of the

selected PC-CARD drive.
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Recording the image (For Windows)
When you wish to record the image of the display to a
PC-CARD.

1. Choose the PC-CARD drive using the drive bar
under the status bar.

7. Click OK button.

8. Repeat steps 4 to 7 for other images.

9. Click the return button.
The presentation window will open. The recorded
image appears on the presentation window.

• Depending on the personal computer, the recorded
image can appear incorrectly. In this case, set the
delay time longer by using the Capture setting
dialog box. Then repeat steps 5 to 7 again.

10. Choose [Save presentation...] under the [File]
menu.
• A presentetion which has been recorded

already, Select “Save As...” to save as.

11. Choose [Exit] under the [File] menu to quit from
PCV.

When you wish to record the image from existing files.

1. Choose the PC-CARD drive using the drive bar
under the status bar.
• If you are using Windows 3.1, select ‘Select card

drive‘ in Option menu of PCV main window.

2. Choose [New presentation...] under the [File]
menu.
The new presentation window will open.

3. Choose [Add image] under the [Image] menu and
then choose [Image file...].
• If you are using Windows 3.1, select ‘Open

image file‘ in File menu of PCV main window.

4. Select the image you wish to record.

5. Click OK button.
The recorded image appears on the presentation
window.

• The maximum number of group (presentation)
that can be recorded to a PC card is 160. If the
capacity of the PC CARD is low, the maximum
number is less than 160.

• The maximum number of the images that can be
recorded to a group is 99.

6. Repeat steps 3 to 5 for other images.
7. Choose [Save presentation...] under the [File]

menu.
8. Choose [Exit] under the [File] menu to quit from

PCV.

Drive bar

• If you are using Windows 3.1, select ‘Select card
drive‘ in Option menu of PCV main window.

2. Choose [New presentation...] under the [File]
menu.
The new presentation window will open.

3. Choose [Add image] under the [Image] menu and
then choose [Screen capture...].
• The PCV windows disappear and the capture

dialog box appears.

Capture setting buttton
Return button

Capture button

• If you are using Windows 3.1, select ‘Image
capture...‘ in TOOL of PCV main window.

4. Display the image you wish to record on the
screen.

5. Click the capture button.
The Compress setting window appears.

6. Select the compress type.

• You can confirm the compressed image by
clicking the Preview button.

• If the command [Preserving the setting] is
checked , you don’t need to set the style of save
by each image (Not Windows 3.1).

Compress type Speed Capacity
High quality Fast Standard
Standard Fast Small
Low quality Fast Very small
No compress (BMP) Slow Large
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Editing the presentation (For Windows)
Delete the image
1. Select the image to be deleted.

2. Choose [Delete image...] under the [File] menu.
• If you are using Windows 3.1, choose [Delete

image] under the [Option] menu.

Sequencing
A. Exchange images
You can exchange the images among images next to
each other.
1. Select an image to be exchanged.

2. Drag the image and drop on the next or previous
image.

Advanced feature with PC (Continue)

Preview an image
1. Double click the image.

The preview image appears on the displays.

{

B. Move images
You can move images to other positions.
1. Select an image to be moved.

2. Drag the image and drop it on the other image
(except next or previous image).
The image will be moved to the previous position
of the dropped image.

{

2. Choose OK to close the image information window.

How to save a file which has been made
by a presentation software (For
Windows 95 only)
1. Make up a presentation by the presentation

software.

2. Choose [Print] under the [File] menu.

3. Set to PCV driver for printing name.

• PCV drive will automatically be installed in
the system of the personal computer when PCV
is installed.

2. Click the image by using the left button of the
mouse (or press Enter key on your keyboard.)

Display image information
1. Choose [Image information] under the [Image]

menu.
The image information window appears.
• If you are using Windows 3.1, choose the image

by clicking the right button of the mouse.



29

E
N

G
L

IS
H

4. Click the properties button. Starting up PCV (For Macintosh)
1. Start up Macintosh.

2. Insert the PC card to the PC Card slot on the per-
sonal computer.

3. Double click the [PCV for Mac] icon.

Command reference
The command references are as shown below:
File

Create New presentation . Create a new presentation.
Open presentation ... Opens an existing presenta-

tion.
Close presentation ... Closes an opened presenta-

tion.
Save presentation .... Saves an opened presentation

using the same name.
Delete presentation . Delete an opened presenta-

tion.
Open image file ........ Import an image from a file.
Done ......................... Exits PCV.

Edit
Cut ............................ Deletes selected image from

the presentation and moves it
to the clipboard.

Copy .......................... Copies selected image data
from the presentation to the
clipboard.

Paste ......................... Pastesimage data from the
clipboard into the presenta-
tion.

Clear ......................... Deletes the selected image
from an opened presentation.

Option
Preference ................ Select the format BMP or

JPEG.
Get Screen Shot Image .... Captures screen and inserts it

to a presentation.

Recording the image (For Macintosh)
When you wish to record the image of the display to a
PC-CARD.

1. Display the image you wish to record on the screen.

2. Press the shift button, command button and
number 3 button simultaneously.

3. Repeat steps 1 and 2 for other images.

4. Choose [Get Screen Shot Image] under the [Op-
tion] menu.
The presentation window will open. The recorded
image appears on the presentation window.

• The file type to be recorded is BMP or JPEG. To
change file type, select [Preference] under the
[Option] menu then change setting. Reboot PCV.

5. Choose [Save presentation...] under the [File] menu.

6. Choose [Done] under the [File] menu to quit from
PCV.

5. If necessary, set the Resolution, Expand, File
Format or JPEG Quality.

6. Click OK button on the PCV driver Properties
dialog box.

7. Click OK button.

8. Choose the PC-CARD drive.

9. Click OK button.
• The presentation data will be saved as PCVdrv

on PC card.
• PCVdrv is a temporaly file. If you record

presentation continuously, the previous data
will be erased. The projector may not work
correctly when playing back “PCVdrv” file on
it. Please follow as below to rename the file.

10. Boot up PCV’s program.

11. Choose [Open presentation...] under the [File]
menu.

12. Select PCVdrv file and click Open button.
The presentation window will open and the
recorded image appears on the presentation
window.

13. Choose [Save presentation As...] under the [File]
menu and click OK button.

14. Click Yes(Y) button.

15. Choose [Exit] under the [File] menu to quit from
PCV.

• The file recorded with PCV driver cannot show
the index display until re-recorded by PCV soft-
ware.
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When you wish to record the image from existing files.

1. Choose [Create New presentation...] under the
[File] menu.
The new presentation window will open.

2. Choose [Open image file] under the [File] menu.

3. Select the image you wish to record.

4. Click OK button.
The recorded image appears on the presentation
window.

5. Choose [Save presentation...] under the [File]
menu.

6. Choose [Done] under the [File] menu to quit from
PCV.

Editing the presentation (For Macintosh)
Delete the image
1. Select the image to be deleted.

2. Choose [Clear] under the [File] menu.

Sequencing
A. Exchange images
You can exchange the images among images next to
each other.
1. Select an image to be exchanged.

2. Drag the image and drop on the next or previous
image.

Advanced feature with PC (Continue)

B. Move images
You can move images to other positions.
1. Select an image to be moved.

2. Drag the image and drop it on the other image
(except next or previous image).
The image will be moved to the previous position
of the dropped image.

{

Preview an image
1. Select an image to be previewed.

2. Double click the image.
The preview image appears on the displays.

{
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Mouse remote control
By connecting to personal computer through the PS/2 (or ADB) port, you can operate your computer with the
projector remote control.

Connection
Projector + IBM PC or IBM PC compatibles

Operation

RS-232C cable 

to RS-232C
terminal

PS/2 adapter

to mouse 
(PS/2) port

D-SUB 9PD-SUB 9PMini DIN 6P Mini DIN 8P

RS-232C cable

to RS-232C
terminal

MAC adapter
for MOUSE

to ADB port

D-SUB 9PD-SUB 9PMini DIN 4P Mini DIN 8P

Projector + Macintosh

right click
This operates in the same way as the right 
button on the computer mouse. 

mouse pointer
Use to move the cursor on the image, 
instead of the computer mouse.

ENTER

R-CLICK

LASER

POWER

RGB VIDEO PC CARD

AUTOPLAYRELEASE
AUTO

POSITION

MENU

left click
This operates in the same 
way as the left button on 
the computer mouse. 

• If the mouse remote control is not working, restart the computer.
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The light source lamp is designed to project the image
on the LCD panels. When the light source lamp no
longer functions, replace it with a new one to ensure
optimum performance.

Caution:
• Do not remove the light source lamp from inside of

this equipment immediately after using the projec-
tor, you may get burned because of the high tem-
perature of the light source lamp.

• When you replace the light source lamp, press the
power button to power off, then wait for 120 sec-
onds in stand-by mode to cool down the lamp and
LCD panels. Turn off  the main switch,  unplug the
power cord from the outlet and wait one hour so that
the lamp is cooled to the touch.

• Do not remove the light source lamp except for re-
placement. Careless treatment can cause injury or
fire.

• Do not touch the lamp element directly. Oil residue
on your hands could cause it to break and cause in-
jury.

• Be sure not to drop the lamp lid screw into the pro-
jector. Also be sure not to insert metal or any flam-
mable objects, it may cause fire or an electric shock.
If any objects are inserted, please unplug and con-
tact your dealer.

• Install the lamp securely, failure may cause a fire.

1. Stand the projector as
shown in the direction of the
arrow.

2. Loosen the screws of the
lamp lid on the top cover us-
ing a phillips screwdriver
(+) , and remove the lid.

• Remove the lamp cover in
the direction of the arrow
as indicated.

3. Loosen screws (a) of fixing metal using a phillips
screwdriver (+).

Replacement of a light source lamp
4. Hold onto the projector by the handle as you pull

out the lamp.
Once the lamp has been removed, do not spill liquid
on it, place it near flammable objects or where chil-
dren can touch it.  Otherwise, it will cause injury or
fire.

5. Insert the new lamp securely into the projector body
in the right direction.

6. Tighten up the screws (a) to hold the piece in place.

7. Tighten up the screws of the lamp lid using a
phillips screwdriver (+).

Screw of the lamp lid

(a)

(a)
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How to reset the operation time meter
Plug in the power cord, switch on the projector and re-
set lamp time by pressing the $, % and POWER but-
tons simultaneously.

Caution:
• The lamp you have removed, do not spill liquids on

it, place it near flammable objects or where children
can touch it. Otherwise, it will cause injury or fire.

• Be sure that the projector guide is firmly inserted
between the right and left lamp guides.

Important:
• The projector will not turn on if you do not secure

the lamp lid.
• The operation time meter must be reset after the

lamp has been replaced.
• Do not reset the operation time meter unless the

lamp has been replaced.

The life of the lamp
The average life of the lamp for the projector is about
2,000 hours of consecutive use. Life span may differ
according to operating environment, and may be shorter
than 2,000 hours. Decreases in luminescence and/or
color brightness will indicate that the light source lamp
is in need of replacement. When lamp operation time
exceeds 1,500 hours, the indicator will flash alternately
between green and red (while the lamp is in operation;
when the lamp is not in operation, the indicator will
appear red only).   When the lamp has been used for
about 1,900 hours, the message “LAMP!!.” will appear
on the screen for one minute. When the lamp has been
used for about 2,000 hours, the projector will automati-
cally shut off for the safety of the lamp and the power
indicator light up in red. The projector cannot be used
until the lamp has been replaced, and operation timer
has been reset.

Caution:
• The light source lamp is fragile. If broken, be care-

ful not to cut yourself with glass fragments.
• The lamp life depends on the environment. For re-

placement lamps, please contact your dealer.

The projector automatically shuts off when
the lamp is used up in about 2,000 hours
and the projector will not come on until
the lamp is exchanged and operation timer
reset.
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Maintenance
Caution:
Be sure to turn off the projector and unplug the power
cord from the wall outlet before you perform any main-
tenance on the projector.

Cleaning the air-filter
Clean the air-filter frequently. If the filter or ventila-
tion slots become clogged with dirt or dust, the tem-
perature inside of the projector may rise and shut off
the power (the TEMP indicator starts to blink red).

1. Press and raise the air-filter cover with a screwdriver
(–).

2. Wash the air-filter.
Use water or a mild detergent diluted with water to
clean the filter. Rinse the filter thoroughly and let it
dry completely. If the filter is damaged or becomes
extremely dirty, contact your dealer for replacement
information.

3. Attach the air filter to the cover.

4. Reinstall the air-filter cover.

Note: The power will not turn on if the air-filter cover
is improperly installed.

Caution:
Be sure to use the projector with an air-filter. If not,
dust may get inside the projector, causing a fire or a
breakdown.

Cleaning the projector and the ventilation
slots
Use a soft cloth to clean the projector and the ventila-
tion slots. When the slots become dirty, wipe them with
a soft cloth dampened with a diluted mild detergent,
and then wipe them with a dry cloth.
To protect the surface of the projector from fading or
deteriorating:

• Do not spray insecticide on or inside the
projector.

• Do not use benzine or thinner to clean it.
• Do not let rubber or plastic materials come into

contact with the projector.

Cleaning  the lens
Use a standard lens-cleaning brush or a piece of lens
tissue dampened with lens cleaning fluid. The lens sur-
face is fragile. Use only recommended, nonabrasive lens-
cleaning materials. Do not touch the lens with your fin-
gers.

FILTER

FILTER COVER
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Troubleshooting
The following offers solutions to some of the common problems you may encounter. We suggest that you consult
this chart before contacting your dealer.

CAUSE

• The air intake vents, exhaust vents  or air filter
is clogged with dust or some object.

POWER indicator does not light up.
• Power cord is unplugged from the outlet.
• Power cord is disconnected from the projector.
• The main switch is turned off.
• The lamp lid is open.
POWER indicator blinks red.
• The projector has been turned on again too soon

after having been turned off.
• When the power switch was turned off while

the fan was running, during or after lamp
operation.

• The room temperature is too high.
(Does the LAMP indicator show an unusual
condition?)

• Lamp is no longer working.
POWER indicator blinks between red and green.
• The filter cover or lamp cover is not closed.
• When the LAMP indicator or the TEMP

indicator is either on or blinking, the main unit
requires repairs.

• Lens is covered by lens cap.
• When the LAMP indicator or the TEMP

indicator is either on or blinking, the main unit
requires repairs.

• The equipment connected to this projector is not
turned on.

• Hookup is not made correctly with other equipment.
• The input source is not selected correctly.

• The projector is not at a right angle to the screen.

• Brightness, tint and color are not adjusted cor-
rectly.

• The projecting distance is beyond the focused area.
• Lens is dirty.
• Screen size exceeds screen size specifications.
• Brightness and contrast are not adjusted cor-

rectly.
• FINE adjustment is not made correctly.
• Tracking is not adjusted.
• The projector is not at a right angle to the screen.

• Remove the object.

• Plug the power cord into the outlet.
• Insert the power cord into the projector.
• Turn the main switch on.
• Close the lamp lid.

• Wait for the lighting sequence.

• Turn the power switch on and off several times.

• Refer to "Indicators" on page 36.

• Replace the lamp with a new one.

• Close the cover correctly.
• Contact your dealer.

• Take the lens cap off.
• Replace the lamp with a new one.

• Turn on the connected equipment.

• Confirm the hookup.
• Select the correct source according to the equip-

ment connected to this projector.

• Adjust the angle of the projector to make a right
angle to the screen. See page 11.

• Adjust brightness, tint and color correctly.

• Adjust the projecting distance. See page 10.
• Clean lens.
• Reduce screen size to within 23" to 245".
• Adjust brightness, contrast.

• Make FINE adjustment.
• Adjust tracking.
• Adjust the angle of the projector to make a

right angle to the screen. See page 11.

• When  you see the stationary image for a long time, it may remain on the screen if you change the
image. It is not a breakdown. The blurred image will disappear in a few minutes.

• It is normal.

• The cable for connection with other equipment
is not plugged securely into the terminal.

• The projector is installed too close to other
equipment.

• Volume is not turned up.
• Connection to other equipment is not made

correctly.

• The PC monitor is not turned on.

• This is typical of the LCD projector.

• The operation is incorrectly made due to noise or
interference.

• Plug the connecting cable securely into the
terminal. See pages 12-14.

• Install the projector far away from other
equipment.

• Turn up the volume.
• Check connections.

See pages 12-14.

• Turn on the monitor.

• Press the MENU and POWER buttons simulta-
neously.  See page 17.

POSSIBLE SOLUTIONSPROBLEMS

The power is off.

No picture appears
on the screen.

The image is
distorted.

The image is dark.

The image is
blurred.

Red, blue or green dots
are viewed on the text of
image.

The image remains
blurred.

The image is
distorted on the
screen and noise is
heard.

No sound is heard.

Adjustments cannot be
made.

Warm air comes out of
the exhaust vents.

Nothing is displayed on
the PC monitor.
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Indicators
The projector has three indicators each of which shows the working condition of the projector.

The following offers solutions to possible problems. If a problem persists, turn the projector off and consult your
dealer.

INDICATOR

TEMP
INDICATOR

SHOWS

blinking red

CONDITION
• Unusual temperature

Normal

Lamp is almost used up.

• Lamp is used up.

• The power is not turned on.
(Power indicator lights up red.)

Standby

Power-on

• The filter cover is not closed.
(When the TEMP indicator and
the LAMP indicator are off.)

• Abnormal
(When the TEMP indicator
or the LAMP indicator-
steady on or blinking.)

Steady green

The power is turned off
and the POWER indicator
lights up red.

• The ventilation slots or air
filter is clogged with dust
or debris.

• The fan has stopped due
to an impediment.

• The room temperature is
too high.

• The filter is dirty.

POSSIBLE SOLUTIONS

• Remove the object from
the ventilation slots.

• Pull out the power
plug and remove the
object. If you cannot,
consult your dealer.

• Relocate the projector
to a cooler place.

• Clean the filter.

-

Replace the lamp.
Exchange with a new
lamp if the same
problem recurs.

-

-

LAMP
INDICATOR

Blinking red/green
or Blinking red

Steady red

Steady green

Steady red

Blinking red/green
or Blinking red

POWER
INDICATOR

• Close the cover cor-
rectly.

• Contact your dealer.

RGBLAMP

TEMP

CARD

SOURCE MENU

ENTER
VIDEO

PC CARD

VOL
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Specifications

LCD projector

AC100 ~ 240V,  50 / 60Hz

2.3A

0.9-inch LCD panel: 3 pieces (for R, G, B)
Pixels 1,024 ×   768 = 786,432 pixels
Total   2,359,296 pixels
Active pixel rate: 99.99 % or more (each panel)

F 1.8~2.1    f = 36 ~ 47 mm

150 W DC mercury lamp

23~245 inch (aspect ratio 4:3)

1 W  monaural

6 cm square type (8Ω 1W) ×     1 pcs.

Luminance signal: 1.0 Vp-p 75Ω    (negative sync.)
Chroma signal: 0.286 Vp-p 75Ω  (burst signal)

1.0 Vp-p  75Ω   (negative sync.)

350 mVrms,  10kΩ or more

RGB: 0.7Vp-p  75Ω (negative sync.)
YCBCR: Y:1.0Vp-p (negative sync.) CBCR:0.7Vp-p
HD/CS : TTL level (positive or negative)
VD : TTL level (positive or negative)

Type

Model

Rated power supply

Rated input

LCD panels

Projection lens

Light source lamp

Picture size

Audio output

Speaker

S-video input

Video input

Audio inputs

Analog RGB input

     (mini D-SUB 15P)

PC audio input 350 mVrms,  10kΩ or more ø3.5mm stereo mini jack

Control connector Serial (Mini DIN 8 pin female connector) RS-232C standards

(performance guarantee)

264 ×115 ×340 mm
(width ×    height ×    depth)

Temperature, humidity

Outside dimensions

Weight

Length of power cord

Approx. 10 lbs  (4.5kg)

114 inch (2.9m)

+41°F (+5°C) ~ +95°F (+35°C),  30~90%

Legs are not included.

LX-D1000




